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Introduction 
 
 

 You will gain the most from this guide by first reviewing it. In addition, be 
sure to back up your data. 

 

TimeslipsBillQuick Conversion Guide helps new users transfer data from Timeslips® (a time billing 
software from Sage Software) to BillQuick® by BQE Software. With BillQuick, you are equipped with the 
most powerful time entry and project management tools in the market. Full-featured, BillQuick Time 
and Billing helps you manage your company, whether your time, expense, billing and reporting needs 
are simple or you require complex billing, reporting and management capabilities. 
 
Conversion means a one-way transfer of data from one program to another. After Timeslips data is 
converted to BillQuick, you have a single database to work with. You can then archive the Timeslips data 
at your convenience. The Timeslips to BillQuick Conversion Wizard, which is built into BillQuick, transfers 
critical information from Timeslips into BillQuick. This easy-to-use tool requires little or no manual 
effort! Compared with a manual conversion, you save days (even weeks) of non-billable time. You can 
start using BillQuick sooner! 
 

 Conversion time varies depending upon the size of your Timeslips 
database. During testing, a 100-MB Timeslips database with over 200,000 time 
entries required 1.5 hours for full data conversion into BillQuick. 

 
 

How to Use This Guide 
 
We encourage you to review How Data Conversion Works section. Written for users with a non-

technical background, it explains the TimeslipsBillQuick data conversion process. Understanding how 
data transfers will help you visualize what is happening behind the scenes. Timeslips to BillQuick 
Conversion Wizard walks you through the entire conversion process, step-by-step. Finally, Data Flow 
explains the Timeslips to BillQuick conversion in detail, including data field mapping across the two 
programs. 
 
 

Software Editions Supported 
 
All BillQuick editions – Basic (Microsoft Access database), Pro (Microsoft Access and SQL Express 
database) and BillQuick Enterprise (Microsoft Access, SQL Express and SQL Server database) – can 
convert data from Timeslips (10 or later). 
 
If you have an earlier version of Timeslips, you need to first update or convert the data to version 10 or 
later. If you need assistance, contact BillQuick Consulting Services at (888) 245-5669. A BillQuick 
Consultant will guide you through the conversion process. 
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How Conversion Works 
 
 

Understanding the basics of TimeslipsBillQuick Conversion is important whether you have a technical 
background or not. It helps you visualize what is happening behind the scenes as BillQuick transfers data 
from your Timeslips program.  
 
The table below shows the flow of data from Timeslips to BillQuick. You can be very specific in 
determining how and what data flows to BillQuick. 
 

Timeslips  
Table Name 

Dataflow BillQuick  
Table Name 

Task  Activity Codes 

Expense  Expense Codes 

Timekeeper  Employee 

Client  Client 

Client Reference  Project 

Time Slip  Time Entry 

Expense Slip  Expense Log 

Invoice-A/R  Invoice 

Payment-A/R  Payment 

 

 To review detailed, field-by-field mapping of records between Timeslips 
and BillQuick, see BillQuick Help, Timeslips Data Conversion, Data Field 
Mapping. 

 
As you can see above, Timeslips conversion with BillQuick is very comprehensive. The major benefit is 
that you do not have to re-enter Timeslips data into BillQuick. BillQuick manages the process, using your 
conversion preferences. 
 
 

Conversion Rules 
 

To ensure accuracy and completeness of data transfer, TimeslipsBillQuick Conversion follows a set of 
rules. These are: 
 

1. Backup Data: Back up your Timeslips databases. Store a copy in another folder or on a 
separate storage device. 

2. BillQuick Database: Create a new BillQuick database prior to transferring data from 
Timeslips. Enter the required information such as Company Name, License Key and 
Registration Key in the Company screen. 
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3. Version: If you have an earlier version of Timeslips, you first need to update or convert 
the data to version 10 or later. This may result in zero invoice numbers. Check your 
Timeslips data for zero invoice numbers before beginning. However, BillQuick can 
handle zero invoice numbers if necessary.  
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Conversion Wizard 

 
 
Existing Timeslips users who are new to BillQuick only need to merge data once. From that point 
onwards, your time and billing information will be in a single database (the BillQuick database). In other 
words, all your historical information – billed and unbilled time and expenses, paid and unpaid invoices, 
payment history – is now in BillQuick. After conversion, you can archive Timeslips at your convenience.  
 
 

Timeslips to BillQuick Conversion Wizard 
 
The Timeslips to BillQuick Conversion Wizard populates your BillQuick Company database with data 
from Timeslips. It automates and controls the conversion, stepping you through the process using a 
wizard to simplify the process. The wizard helps you to accomplish tasks that can be complex for the 
first time users and require experience.  
 
To convert data from Timeslips to BillQuick, follow the steps mentioned below: 
 
1. Creating BillQuick Company 
 
As a new BillQuick user, you must first create a new BillQuick company database (see BillQuick Help and 
other documentation for more details). 
 

1. In BillQuick, select File menu, New Company. Choose the type of database technology you want 
to use. If unsure, choose Standard.  

 

 The database technology available to you depends on the BillQuick Edition 
purchased. If you are unsure what edition you licensed, select About BillQuick 
from the Help menu. The edition abbreviation displays right after the version 
number. 

 

Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Express 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Express 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog box, enter a name for the new database. Most commonly, 

the company name is used for easy identification. Click the Open button. BillQuick creates the 
database and opens the BillQuick Start-Up Interview wizard. 

 



Conversion Wizard 

TimeslipsBillQuick Conversion Guide 2014 v.2              Page 5 

 The BillQuick Start-Up Interview can be closed and reopened later. To do 
so, select Wizards, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview page, click the Next button.  
 
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity 

(service) and expense codes into your company database. These codes are not needed because 
items will transfer from Timeslips into BillQuick. Click the Next button.  

 
5. Custom Labels allow you to change key business terms to suit your professional and company-

preferences in BillQuick. Customizing terms eases transition from your old time and billing 
solution. Select your preferred terms from the drop-down lists. When you have finished, click 
the Next button. 

 
6. On the Company Name page, enter your company name. Spell it exactly as it appears on your 

License and Registration or the Evaluation Key document or email.  
 

 
 
7. Click the Next button to accept the defaults on the remainder of the pages. You can update 

these options later in the Global Settings and User Preferences screen. On the last page, click 
the Finish button. 

 
8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to 

create master information (employee, client, project, and so on). Skip this step as you shall 
transfer this data from Timeslips. Click the Close button. 
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9. Next, the Company screen displays. Either complete the data entry now and click the Save 
button when you have finished; or click the Close button and perform this task later.  

 
10. From the File menu, 

select Login. For 
User ID, type 
‘supervisor’ (without 
quotes), then for 
password, type 
‘supervisor’ (without 
quotes). This gives 
you full security 
permissions in 
BillQuick to perform 
conversion tasks.  

 
 
 
 
 
 



Conversion Wizard 

TimeslipsBillQuick Conversion Guide 2014 v.2              Page 7 

2.  Backing up Database 
 
Before beginning the conversion, create a security backup of your BillQuick and Timeslips databases. 
Store a copy of each database in a separate folder or on a separate storage device.  
 
To backup data in BillQuick, select Utilities menu, Backup Database. For Timeslips, please use your 
normal backup procedure. Close Timeslips before continuing. 
 
3.  Converting Data 
 

1. Open the Timeslips to BillQuick Conversion Wizard from the File menu or View menu.  
 

2. Click Next on the Welcome page.  
 

3. On the Select data file page, verify the BillQuick Data File to be used for data transfer. If it is not 
the one you want to use, click Browse to navigate to the location where it is stored.  
 

 
 
Next, Browse to the location where the Timeslips Data File is located and select it. If you are 
converting a Timeslips 2006 or older version, check the option provided. 

 

 If you close and then return to Timeslips to BillQuick Conversion Wizard at 
a later time, the program remembers the location entered for the databases. 

 
4. Address Field Mapping page displays the BillQuick field names. From the drop-down lists, 

identify which Timeslips fields map to these BillQuick fields. The most common choices or 
defaults are already selected.  
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Phone, Fax, Email, Street, Street2 and Country are the field names representing address 
information in BillQuick. For Employee ID, Activity ID and Expense ID in BillQuick, select what 
field you want to save the value for. See the table below for the options in each drop-down list. 
 

BillQuick Fields Timeslips Fields 

Phone Phone1/2/3/4, Address Line1/2/3/4, None 

Fax Phone1/2/3/4, Address Line1/2/3/4, None 

Email Email Address, Phone1/2/3/4, Address Line 1/2/3/4, None  

Street 
 

Phone1/2/3/4, Address Line 1/2/3/4, None  

Street2 Phone1/2/3/4, Address Line 1/2/3/4, None  

Country Phone1/2/3/4, Address Line 1/2/3/4, None  

Employee ID Default, Nickname1, Nickname2 

Activity ID Default, Nickname1, Nickname2 

Expense ID Default, Nickname1, Nickname2 

  

 For detailed field mapping between Timeslips and BillQuick, see Data Flow 
section. 

 
5. Move to the Client and Job Field Mapping page. Select Timeslips fields from the drop-down lists 

and map them to the BillQuick fields. Default choices are pre-selected.  
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See the table below for the values in each drop-down list. 

 

BillQuick Fields Timeslips Fields 

Client ID Default, Nickname1, Nickname2 

Project ID Default, Nickname1, Nickname2 

Client Name Client Name,  AddressLine1/2/3/4, None 

Project Name Client Name, Nickname1, Nickname2 

Project Separator None, Nickname2, - .  /  :  ; < = > ? (more) 

 
6. Timeslips employs two methods to create projects-the Client References and Client Projects 

method. 
 

If you used the Client References method, check the ‘Copy Client References as Projects’ option 
to convert the Timeslips Client References to BillQuick Projects. 
 
If you used the Client Project method, do not check the box. In the Client Project method, 
Timeslips employs project separators to create multiple projects. For example, if Client A has 
two projects, they may be identified as A.P1 and A.P2. In this case the Project Separator is a 
period by default.  
 

 When the Client Project method is used, BillQuick automatically identifies 
the client name as the text to the left of the project separator. This text 
transfers to the Project Name field as the default value. You can easily change 
project names in BillQuick.  

 
7. If you needed to convert your older Timeslips database to a newer version, you were asked to 

check if there were any zero invoice numbers. If there are, check the Copy Zero Invoices option 
here. If not, leave the box unchecked.  

8. Click the Previous button and verify your choices.  
9. When ready, click the Finish button to start the conversion process. A progress bar keeps you 

informed about the data transfer.  
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Data Flow 

 
 
Data conversion from Timeslips to BillQuick is completely automated with the Timeslips to BillQuick 
Conversion Wizard. However, if you want more details on how Timeslips data maps to BillQuick data, 
please review this section.   
 

 For additional information, see BillQuick Help, Timeslips Data Conversion, 
Data Field Mapping. 

 
 

Data Field Mapping 
 
Data is stored in various tables in Timeslips and BillQuick databases. Below is a list showing the flow of 
data from Timeslips tables (modules) to the corresponding BillQuick tables (modules). 
 

Timeslips  
Module Name 

Dataflow BillQuick  
Module Name 

Task  Activity Code 

Expense  Expense Code 

Timekeeper  Employee 

Client  Client 

Client Reference  Project 

Expense Slip   Expense Log 

Time Slip  Time Entry 

Invoice-Account 
Receivable 

 Invoice 

Payment-Account 
Receivable 

 Payment 

 
Data fields in Timeslips map to corresponding fields in BillQuick. Below are the field mappings between 
Timeslips and BillQuick for each data table (module). The tables below include default values that 
transfer from Timeslips to BillQuick. If you chose to send a different value, for example, Nickname 2 for 
Employee ID, the values would change accordingly. 

 

Timeslips Timekeeper Dataflow BillQuick Employee 

Nickname 1  Employee ID 

Full Name  Last Name + MI + First 
Name 

*($1.00 by default)  Bill Rate 

Overhead Cost  Cost Rate 

* Employee Bill Rate does not exist in Timeslips. However, as it is a required field in BillQuick, a 
placeholder of ‘$1.00’ is inserted in the Bill Rate field. 
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Timeslips Client Dataflow BillQuick Client 

Nickname 1  Client ID 

Full Name  Company 

Address 1  Street 

Address 2  Street2 

City  City 

State  State 

Country  Country 

Zip  Zip 

Phone  Phone 

Fax  Fax 

Classification: Open, 
Inactive/Closed 

 Status: Active, Inactive 

 

 

Timeslips Task Dataflow BillQuick Activity 

Nickname 1+ Nickname 2  Activity ID 

Nickname 1  Code 

Nickname 2  Sub 

Bill Status: 
Billable/Ignore/Override, 

Do Not Bill/No Charge 

 Billable:  
-1, 0 

Full Name  Description 

Description  Memo 

Classification: Open  Inactive: 0 

 
 

Timeslips Expense Dataflow BillQuick Expense 

Expense (Nickname1+ Nickname2)  Exp ID 

Nickname 1  Code 

Nickname 2  Sub 

Full Name  Description 

Billable Status:  
Billable/Ignore/ Override 

 Billable 

Classification:  
Inactive/Closed, Open 

 Inactive: -1, 0 
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Timeslips Client Reference Dataflow BillQuick Project 

Nickname 1:NickName 2  *Project ID 

Nickname 1  Code 

Nickname 2  Phase 

Nickname 1  Name 

Client  Client ID 

‘From Timeslips’  Employee ID 

* To ensure compatibility and correct data processing, BillQuick automatically takes the name on the left side 
of the project separator as the BillQuick Project ID when no client references (projects) exist in Timeslips. 

 

Timeslips Time Slip Dataflow BillQuick Time Entry 

Timekeeper  Employee ID 

Reference  Project ID 

Task (Nickname 1 + Nickname 2)  Activity ID 

Time Spent  Hours 

Memo  Description 

Start Date  Date 

Billing Status: Billable/Override  Bill: -1 

Rate  Bill Rate 

Rate  Cost Rate 

Memo  Memo 

*Reference  Project Name 

Time Estimated  Hours 

* If the Reference is blank or None in Timeslips, BillQuick creates a Project Name using the 
Timeslips Client name. 

 

Timeslips Expense Slip Dataflow BillQuick Expense Log 

Timekeeper  Employee ID 

Reference (Nickname1+ 
Nickname2) 

 Project ID 

Expense (Nickname1 + 
Nickname2) 

 Exp ID 

Memo  Description 

Price  Cost 

Billing Status: 
Billable/Override, Do Not 

Bill/No Charge 

 Billable:  
-1, 0 

Value  Charge Amount 

Memo  Memo 

Start Date  Date 

Quantity  Units 
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Timeslips Invoice Dataflow BillQuick Invoice 

Inv No.  Inv # 

Date  Date 

*Client Name  Project ID 

*Client Name  Project Name 

Amount  Amount 

Balance  Balance 

Total Paid  Paid 

‘From Timeslips’  Client ID 

‘From Timeslips’  Employee ID 

* Project ID is required in BillQuick and hence a Project ID is automatically created from the Client 
name in Timeslips if no client reference (project) exists therein. 

 
 

Timeslips Payment Dataflow BillQuick Payment 

Client  Client ID 

Payment Date  Date (payment) 

Payment Amount  Amount (Payment) 

Memo  Memo 

 
 

 
 
Congratulations! You have now an understanding of data flow from Timeslips to BillQuick and how to 
ensure that the data transfer is accurate. To learn more, check the BillQuick Help. 

 
For more information, visit us at www.bqe.com.If you have any trouble in using the conversion tool, 
please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please call 
us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com. 

http://www.bqe.com/timeslips/
mailto:Support@bqe.com
mailto:Sales@bqe.com
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